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Appendix B: Creating simple Agents 

Agents are simple programs that let you perform repetitious tasks quickly and 
simply.  You can use agents to automate almost any task that you can perform 
manually in a database.  You can also use search options to select only articles 
matching your criteria and then create agents to perform tasks with those matching 
articles. 
For example, you might want staff to receive an email each week that lists all active 
articles that have not been modified in the past year.  You might also want a daily 
update of articles that have been created or modified in the past day. 

Agents can be: 

•	 private - used only by you; or 

•	 shared - able to be used by other people who use your database. 

No technical knowledge? No problem! 

You do NOT need any programming or technical knowledge to create simple 
agents and you may create as many agents as you like. 

OBJECTIVES 

By the end of this chapter you should be able to: 

•	 create simple agents 

•	 create an agent using a worked example 

•	 test your agent 

•	 use your agents 

•	 view at a list of your agents 

•	 edit an agent 

•	 delete agents (that you created) that you no longer need. 

WHERE TO GO FOR MORE HELP, OR FOR AGENTS REQUIRING PROGRAMMING 
SKILLS 

Complex agents and agents requiring programming skills are outside the scope of 
this User Guide. If you need to use complex agents consider the following two 
options: 

•	 see your system administrator – they may be able to write the 
agent for you. Remember, you must know what you want the 
agent to do (you don’t need to know how to do it though).  Your 
system administrator may also be able to refer you to useful 
reference materials. 

•	 refer to the Lotus Notes online help – Context Sensitive Help is 
represented by a question mark in the right top corner of dialogue 
boxes. Click on the question mark to see help about the feature 
you are currently at. If you do not have a dialogue box open press 
<F1>. 
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CREATING AGENTS 

Important 

This section does NOT cover each option available when you create agents.  Only 
very simple agents, requiring no programming knowledge are discussed.  If you 
need to use more complex agents see your system administrator. 

1.	 Open the database in which you want to create the agent. 

2.	 Go to the Create menu. 

3.	 Select Agent… 

4.	 The Agent properties dialogue box and the Programmer’s pane display. 

Note 

You must select criteria from BOTH the Agent properties dialogue box and the 
Programmer’s pane to create a working Agent. 

The Agent properties dialogue box contains the name, description and details the 
conditions the agent will run under – when and the how the agent will do 
something.  The Programmer’s pane contains the actions – what the agent will do. 

Figure 213: New agent showing Agent properties dialogue box (in foreground) and 
Programmer's pane (in background). 

Agent properties dialogue box 

1.	 Name: Enter a name for your agent. 

2.	 Comment: Enter a description of the agent.  The comment appears in a list 
of agents. 
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3.	 Options: You may notice that some of the options are greyed out 
(unavailable). The availability of options depends on your level of access 
to the database in which you are creating the agent. 

•	 Shared / Private – If you want to share this agent with other people 
who use your database click on the Shared option. If you are the 
only person who will run this agent click on Private. 

•	 Store search in search bar menu – if your agent is going to search 
for text in articles you can display your search criteria in the 
Search bar. 

•	 Store highlights in document – if your agent is going to search for 
text in articles you can highlight the matching text in the articles. 

•	 Run in background client thread – if you select this option your 
agents will not be seen by a user.  However if you are using agents 
to email people this is OK!  Don’t worry too much about this 
option. 

1.	 Runtime: You need to select a “trigger” for your agent.  Triggers cause the 
agent to be run. You can select either: 

•	 On event – select a particular event, from the dropdown list under 
the trigger field, which will trigger the agent.  L see below, 
Runtime trigger: On event for more detail about the On event 
options. 

•	 On schedule – schedule the time, day or frequency that the agent 
will run. L see below, Runtime trigger: On schedule for more 
detail about the On schedule options. 

Runtime trigger: On event 

1.	 You now need to select the event that will run your agent.  The following 
options are available: 

•	 Action menu selection: The agent will be listed as an option in the 
Action menu.  When you want to run the agent you need to go to 
the Action menu and select the agent.  This is useful if you want to 
run the agent at varying intervals. 
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Figure 214: Action menu selection - the agent using this trigger is 
"Frances' agent". 

•	 Agent list selection: For agents that are “called” by other agents – 
that is, other agents use this agent.  DON’T WORRY ABOUT 
THIS ONE. 

•	 Before new mail arrives: Works on every item of mail before it is 
received in your mailbox.  Can be used to move incoming mail to a 
folder. Use this option with care. 

•	 After new mail has arrived: Works on newly received mail.  
Particularly useful if you have just sent out many emails and 
people are responding to them – for example a client survey.  You 
can use this option to send automated replies. 

•	 After documents are created or modified: DON’T WORRY 
ABOUT THIS ONE. May be used for workflow tasks, but the 
edDesk article workflow tab replaces the need for this option. 

•	 When documents are pasted: DON’T WORRY ABOUT THIS 
ONE. Used for articles that must be modified when they are 
pasted into a database. 

2.	 Target: select the articles on which the agent will be run.  Your options in 
the Target field vary depending on the Runtime trigger you selected. For 
example, the event runtime triggers “Before new mail arrives” and “After 
new mail has arrived” only act on mail items – not on articles. All available 
options are listed below. 

•	 All documents in database 

•	 All new and modified documents 

•	 All unread documents in view:  You select article search criteria 
and your agent only acts on articles matching those criteria. 
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•	 All documents in view: You select article search criteria and your 
agent only acts on articles matching those criteria. 

•	 All selected documents. 

•	 None. 

3.	 Click on the close icon (top right of the dialogue box) when you have 
entered your agent properties. 

4.	 The Programmer’s pane is displayed. 

Runtime trigger: On schedule 

1.	 If you have selected On schedule as your runtime trigger you must select 
the frequency of the agent’s running. 

•	 More than once a day: Only used for very high priority items.  If 
you schedule very frequent runs you could slow your server! 

•	 Daily: For important items that you only need to know about once 
a day. itechne uses this for sending out a list of articles that have 
been modified or added in the day. 

•	 Weekly: For routine tasks, particularly useful for summary reports 
so you can see what has happened during the week. 

•	 Monthly: For low priority tasks. For example, archiving articles, 
distributing monthly newsletters. 

•	 Never: DON’T WORRY ABOUT THIS ONE. 

2.	 Click on <Schedule…>. The Agent Schedule dialogue box displays. 

Figure 215: Agent Schedule dialogue box, where you enter the schedule by which 
to to run your Agent. 

3.	 Use the Agent schedule dialogue box to specify the schedule by which 
your agent is run. Remember that agents do take up system memory, and 
complex agents, or agents running on many articles, will slow your 
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database down when they run. Specify a sensible schedule that has 
minimum impact on other users. 

•	 Run Agent Once Every Day: Select the time your agent is to run.  
It will run at the same time each day (until you change the time). 
Start running agent at: If your agent is system intensive (takes a 
lot of memory, or will have to search through a lot of articles) 
select a time when you know that there are fewer people using 
your database. 

•	 Restrict Dates When Agent Runs: These options are used to 
restrict the dates the agent runs.  If you only want to use an agent 
for a particular period or not on the weekends you need to select 
your criteria here. 

Start running agent on this date. If you want to start running your 
agent on a particular date click on the checkbox then enter the first 
date you want the agent to run. If you are not sure of the date 
format click on the calendar icon next to the date.  A calendar is 
displayed. Select the required date. 

Stop running agent on this date. If you want to stop running your 
agent on a particular date click on the checkbox then enter the last 
date you want the agent to run. If you are not sure of the date 
format click on the calendar icon next to the date.  A calendar is 
displayed. Select the required date. 

Don’t run agent on weekends. If you don’t want your agent to run 
on weekends, check this option. 

•	 Where the Agent Runs: Only change this option if you know 
which servers your database uses.  Most people will leave this 
option at -Any Server-. 

4.	 Click on <OK> when you have set your Agent Schedule. 

5.	 Target: select the articles on which the agent will be run.  On schedule has 
only two options: 

•	 All documents in database 

•	 All new and modified documents 

6.	 Click on the close icon (top right of the dialogue box) when you have 
entered your agent properties. 

7.	 The Programmer’s pane is displayed. 

Programmer’s pane 
The Programmer’s pane is where you select the actions done by the agent.  That is, 
what the agent does. You can also specify which articles are to be selected. 

The Programmer’s pane is divided into two panes – the left pane is the Objects 
tab. There are two available option s - Document Selection and Action. Document 
Selection is not always used, but it is where you can specify that the agent run on 
only a particular set of articles.  Use Document Selection if the Agent properties 
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dialogue box did not allow sufficiently refined article selection criteria.  Action is 
always used and is the selected option when you first enter the Programmer’s pane. 

 Action object 

1.	 Click on <Add Action…>. 

2.	 The Add Action dialogue box displays. 

Figure 216: Add Action dialogue box on entry, showing default action of "Modify 
Field". 

3.	 Action: The default action is Modify Field. Click on the dropdown list to 
see a list of available actions. Look at the bottom of the dialogue box - 
outlined in blue is a description of what the selected action does. 
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The options for the actions change as you select different actions.  Compare 
Figure 216, above, with the Add Action dialogue box below (after a 
different action has been selected). 

Figure 217: Add Action dialogue box with a the Action “Move to Folder” selected.  
This action moves articles specified in the Agent properties dialogue box to the 
selected folder. 

4.	 Select the required action and the parameters that your selected action needs 
to be completed.  (In Figure 217, above, the parameter is to select the folder 
to which you want to move your articles). 

Some Actions have no parameters. 

If there are no parameters for an action the blue action description box will 
contain “This action does not require any parameters.”  There will be 
nothing for you to select other than the action itself. 

5. Click on <Add>. Your action is added to the agent and appears in the 
Programmer’s pane. 

Figure 218: Action “”Move to Folder” now added to programmer's pane. 
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6. If you want to add more actions for your agent to perform repeat steps 3 to 
5. Actions must be added in the order that you want them to be run. 

Document Selection object 

1.	 Click on Document Selection in the Objects tab. 

2.	 The Programmer’s pane displays as below: 

Figure 219: Document Selection object selected in the Programmer's pane. 

3.	 Click on <Add Condition…>. The Add Condition dialogue box displays. 
L see section 5.6i: Conditions for details on specifying the most commonly 
selected conditions. 

SAVING YOUR AGENT 

Do one of the following: 

4.	 Press <Ctrl> + s; OR 

5.	 Select the File menu then select Save; OR 

6.	 Click on the close icon (the cross at the top right of the Agent tab name).  
You are prompted “Do you want to save your changes?” 
Click on <Yes>. 

TESTING YOUR AGENT 

It is important to test your agent to make sure that it runs correctly. 

If your agent is going to manipulate articles, or email you a list of new or modified 
articles then create at least one new article so that you receive some indication that 
the agent is running correctly. 

Have a new or modified article ready 

It is best to ensure that there is at least one new or modified article in your database, 
so that you can see exactly what the email will look like.  If necessary create a 
dummy article (you only need to complete the mandatory fields in the Basics 
tab). 

1.	 Close the agent (click on the cross at the top right of the Agent tab name). 

2.	 Go to the View menu. 

3.	 Select Agents. A list of all of your agents is displayed. 
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Figure 220: List of all of my agents. 

4.	 Highlight the agent that you want to test. 

5.	 Go to the Agent menu. 

6.	 Select Test. 

7.	 After the agent has been tested a Test Run Agent Log displays. 

Figure 221: Test Run Agent Log 

8.	 Read the Test Run Agent Log carefully as it tells you about the total 
number of articles in your database, how many meet the criteria specified 
by the agent and what will happen to those articles.  In the Log above a 
newsletter summary will be sent to recipients specified in the programmer’s 
pane. 

9.	 Click on <Done>. 

DELETING AND DISABLING AGENTS 

Only delete agents that you have created and that only you run!  If you are not sure 
that you are the only person who uses an agent disable it instead of deleting it. 

Delete – permanently removes the agent from the database. 

Disable – the agent is still in the database, but it cannot be run. 

Deleting an agent 
1.	 Go to the View menu. 

2.	 Select Agents. The Agents list is opened. 
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3.	 Select the agent to be deleted. 

4.	 Press <Delete>. You are prompted Delete agent ‘(agent
name)’ permanently from the database? 

5.	 Click <Yes>. 

Disabling an agent 
1.	 Go to the View menu. 

2.	 Select Agents. The Agents list is opened. 

3.	 Select the agent to be disabled. 

4.	 Click on <Disable>. 

WORKED EXAMPLE – AN AGENT TO SEND A DAILY EMAIL THAT LISTS NEW AND 
MODIFIED ARTICLES 

This agent sends an email each weekday morning (at 8:30am) to other people in an 
organisation. The email lists all new and modified articles in a database.  Each new 
and modified article has a link so that people can open the article.  Other information 
displayed is the article author, modification or addition date, article size (in bytes) 
and article subject. 

1.	 Open the database in which you want to create the Agent. 

2.	 Go to the Create menu. 

3.	 Select Agent. 

Agent properties dialogue box 

4.	 Name: Type “New and Modified Articles” 

5.	 Comment: Type “sends daily email about new and modified articles” 

6.	 Trigger: Select On schedule. 

7.	 Select Daily from the dropdown list. 

8.	 Click on <Schedule…> 

9.	 Start running agent at: Click on the clock icon in this field. 

10.	 Scroll through the list until the time displayed is 08:30AM. 
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11.	 Click away from the list. You are returned to the Agent Schedule dialogue 
box. 

12.	 Don’t run agent on weekends: Select this. 

13.	 Click <OK>. 

14.	 Target: select All new and modified documents. 

15.	 Close the Agent Properties dialogue box. 

 Programmer’s pane 

16.	 Look down at the bottom of the pane.  Click on <Add Action…>. 

17.	 Action: Click on this list and select Send Newsletter Summary. 

18.	 To: Type the email addresses of the people to whom you are sending the list 
of new and modified articles. If you have a group contact list, you may 
type its title. For example, #staff@company.com. 

19.	 Subject: Type New and Modified Articles. 

20.	 Send the following message: This field is for text that appears in the 
body of an email.  Type The following articles are new or have been 
modified: 

21.	 Include summary for each document using view: Make sure this field 
is ticked. Then select All Documents. Your email will include information 
displayed in the view “All Documents” (a very useful view!). 

22.	 The Add Action dialogue box should look like the one below.  (The 
address of the recipients will be different) 
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Figure 222: Completed Add Action dialogue box as per the instructions in this 
example. 

23.	 Click on <Add>. 

24.	 Your action is now added to the agent. The Programmer’s pane is 
displayed as below. 

Figure 223: Programmer’s pane after you have completed the Add Action dialogue 
box. 

25.	 Save your agent by either: 

•	 going to the File menu then selecting Save OR 

•	 pressing <Ctrl>+s 

26.	 Close the agent.  (Click on the cross in the agent’s tab). 
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Test your agent 

Have a new or modified article ready 

It is best to ensure that there is at least one new or modified article in your database, 
so that you can see exactly what the email will look like.  If necessary create a 
dummy article (you only need to complete the mandatory fields in the Basics 
tab). 

27.	 Go to the View menu. 

28.	 Select Agents. 

29.	 Highlight the agent you want to test. 

30.	 Go to the Agent menu. 

31.	 Select Test. 

32.	 Read the Test Run Agent Log carefully to make sure that your agent has 
run as expected. Make any required modifications to your agent. 
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